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Disclaimer

Considerable time, effort and expense have gone into the development and documentation of
S-FRAME. It has been thoroughly tested. However, in using the product (including manuals), the
user understands and accepts that no warranty on the accuracy or reliability of the product is
expressed or implied by the developers or distributors. Users must understand the assumptions
used in the product, know its limitations, and verify their own results.
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o This symbol indicates that video tutorial on the related topic exists in the S-FRAME help system.
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Thank you

Thank you for your interest in S-FRAME Analysis. Rest assured; you have made the right decision by
selecting not only a proven software solution but also 35+ years of structural analysis and design
support expertise at your disposal. Our application engineers look forward to building a supportive
and productive relationship with you.

We understand that like many powerful software products, S-FRAME Analysis can appear daunting
at first to the new user. With so many features and options available. To help ease your transition to
working within S-FRAME Analysis and ensure that you get the maximum benefit in minimum time
we have developed this Quick-Start guide for new users. By following the steps in this guide, you
should be able to create, analyse and review results for a simple model in approximately 1 hour.

Once you have completed the Quick-Start guide, bigger (more realistic) models may be to some
extent just a matter of repetition. However, you probably want S-FRAME to do the repetitive work
foryou and there are numerous S-FRAME features designed to speed up your modeling and analysis
workflow. To help you progress from an S-FRAME “novice”to an S-FRAME “expert,”you can find many
more worked examples within the S-FRAME Help system and the detailed manuals supplied in
electronic (.PDF) format.

Finally, we always encourage and welcome user comments and ideas about S-FRAME. Your input is
important because client feedback helps to ensure that S-FRAME Analysis’ ongoing development
continues to meet your requirements. Many of S-FRAME’s current features come from our direct
interaction with customers like you. We are committed to maintaining and updating S-FRAME, and
your contributions are vital to this.
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How to Use the Quick-Start Guide A

The S-FRAME Analysis Quick-Start guide is comprised of two parts.

Part | (Chapters 1 through 8) includes an overview of S-FRAME Analysis’ basic tasks and features. Each
chapter is further divided into smaller units, highlighting a specific area of study, method or concept. The
reader may optionally practice these features while reading through, or simply read through Part1 and use
the Example at the end for practice.

Part Il (Chapter 9 and10) contain a complete step-by-step practice example designed to show the reader
how to create, analyse and design a simple 3 story structure. By carefully following the provided steps you
can ensure to take away as much as possible from this guide. The model file is included as part of the guide.

Chapter 10 provided information on how to get technical support and additional training.
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Within the Guide are screenshots and diagrams, emphasizing a certain step or results. In some cases, they
indicate the correct data entry for a specific dialog:

B Preferences

Preferences Dialog Boxis Common to AllVWindows...

x|

General

T Salver T Results T Design Codes

% Include joints when selecting/unselecting objects Cursor Tolerance 'ﬁ
Performance Dptions

[ Automatic group update:

[® Open files quickly

[ Save files quickly

[ Model using physical members

[ Bypass startup wizard

Options Applicable to Geometry and Load Windows

[ Always preserve loads during element subdivision

X Alwaps copy Ioads during a paste opration

Options Applicable to the Spreadsheet Window
[ Replace numerical codes with more detailed drop down combo boves

[ Include arthatropic material properties

Use one of these delimeters when wiiting a ‘“TEL" file
@ Tab O Semicolon O Colon O Other 1@

Options Applicable to the Loads Window and Graphical Results Window
[ Fill member load arow heads with member load color when madel tpe is 2D

[ Fill triangular and quadrilateral elements with colar when madel type is 20

[~ ‘when rendering, render before generating result diagrams

LCancel

Help

In other cases, they may show the expected output of a process:

1. DEFINE GEOMETRY.TEL
1- Self Waight

Good to Know: Scattered throughout this guide in green boxes are short “Good to Know” facts.

Need to Know: Scattered throughout this guide in red boxes are short “Need to Know” facts.

Further Information: Scattered throughout this guide in blue boxes are additional resources
for specific topics.

Proprietary Information of Altair Engineering

J\ ALTAIR



Altair S-FRAME 2021.1
Quick Start Guide

1.0 First Steps

Once S-FRAME Analysis is installed and licensed, opening the program displays the Product Home Page
window. This window opens, by default, once a day for every S-FRAME execution. It includes the version

history and any upcoming technical webinars and training classes.

wutaed Verslon: 290 Latint Veriors 1270

D serave

5-FRAME Software News
| webinass oo |
+ P — -
)

~

Snabone Liere expiret in 380 dis

Farning Dpmamit Aaalysis in & FRAND

210

Improved the output of B wiiftress mabris for Academic trad s

Upeate of Splash Sereen

Error Foees 11200

Amadyain Errer Floes 182210
Close

Figure 1. Product Home Page

Clicking on the green button, closes the product home page window and launches S-FRAME Analysis, but
you can always re-open this home-page window it by selecting the S-FRAME drop-down menu item:

Help -> Show Home Page

) s-FRAME
File Settings Window | Help

Contents...
Online Resources
About 5-FRAME...

Show Home Page...

Figure 2. Displaying the Product Home Page

If you have not yet done so, click on the green close button to launch S-FRAME and open the Open

Structure dialog window.
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The Open Structure dialog is used to quickly access previously opened model files or to define a new model.

Qpen Structure

Y | X B | @

CpenFile | Cancel | Browse | New 2D, | Mew 20 | Rename.. | Copy.. | [ekete | Help

s

| & | @ |@

Fi Hame:

IE:U.lsefs\P\.ﬂ\:'\DncllnulﬂS-FFthMi Software\S FRAMEAT wonalPART1.TEL

Laxt Fie: Opened: [

Pioject Hame: [

Stuaches Descripborr |

Engineer [

Drges: | = o [wWindaws]
Diinctos

AUzers
124 Pubilic

A Documentz
{A5-FRAME Soltware

‘15 FRAME

dai

Ares Load Stage 1, tel
Diaphaagms Example 1 stage 1.tel
Flat Slab Model Stage 1, TEL

Flat Slab Model Stage 2, TEL

Flat Slab Moded Stage 3, TEL
Floos Joists Stage 1,TEL

Gridz Example 1 Stage 1, TEL
Moving Load Ex 1 stage 1.tel
HMoving Load Ex 1 stage 2,tel
Fanel TEL

Part2.tel
Part3.tel

Figure 3. Open Structure Dialog

To create a new 3D structure, click the New 3D button, to open the New Structure dialog window.

Hew Structure

Froject Hame
Stchae Descrption

Ergnest

Comguany Hame

Slabe oo Frovince.
Telephure:

Focint

[Dusck 51t Giuade

| Dk Siat Modsdl

[5-FRAME Engreer

|S-FRAHE Scitware |

[27 Dloomsby Sauare

|Lendon

|Urited Fingdon

[ s

L]

i

Figure 4. Project Titles

Here, the user would enter any of the Project title fields. This information appears on project reports

generated from the structure. These fields can be edited later. Click Next.
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In the next steps, the Input Units, the Results units, the Modeling Options and the Design Codes are defined.

Mew Structure.

Select Input Units Cancel
Lt |
e |
Freferences. .
Data
Category
Propaities
Metic
Matensk
Nodes Impeial
Spiing K
Loads

E

Figure 5. Input Units

Click Metric for the input units followed by Next to proceed to the Results Units. Note that it is possible to
create a model in one unit system, but have the results displayed in a different unit system

MNew Structure
Select Result Units
LCancel
Metric; Preferences.
Data Length Force H
Categam Units Units
il Imperial
Displacemerts Milimeters -
Forces Meters - | Kilonewton
Shesses Millimeters t MNewton t
Help

Figure 6. Results Units

Click Metric for the Results Units followed by Next to proceed to the Modeling Options.

Hew Structure
Concel
Model Tomance [ 007 m "—“"I
IS0 Model using physcal memben: finck
e
Model Types = =
£ 20 Fiame
30 Frame
Dptsans [A nly I Epderpiien Edidion]
™ Thes struchae | g e
__tw |

Figure 7. Modeling Options

Accept the defaults at this dialog and click Next to define the Design Codes.

You can find useful information for the Model Tolerance settings, in S-FRAME'’s Help System
(Help = Contents = ‘Search Tab’) under the ‘Integrity Checks' topic.
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Specify the desired design codes for Concrete and Steel Design and click Next.

Hew Structure

Buikding Code
ik |
|
Conciele Dengn Code
[EE2 2004 ALY -

Stoml Distabiasn and Sl Dasin Coda
Sesel Databae [Eurcesan -

el DeignCode | ECIE008 UK Arer -

Figure 8. Design Codes

Once we have specified the modeling options, the Model Generation Options dialog open. Here you can
invoke various wizards to generate different model types. To create our simple model from first principles,
click Start from Scratch - Open a blank model and then click Finished.

Mew Structure
FEinished
Generate New Structure

LCancel
f* - Start from Secratch - Open a blank madel |
- Create a Regular Frame "Wwoark. Preferences.
- Create a Parallel Chord Truss
" - Create a Standard Pitched Roof Truss
- Create a Custom Pitched Roof Truss
- Other Miscellaneous Trusses

Help

Figure 9. Model Generation Dialog Window

At this stage, the S-FRAME launch process has completed, and S-FRAME’s Geometry window opens next for
the user to begin defining the structure’s geometry.

S-FRAME remembers your Input Units, Result Units, and Preference settings. In future, you will
only need to access these dialogs to make changes or to ensure that no one else has made
changes since you last used S-FRAME.
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2.0 The S-FRAME Graphical User Interface @

p.7

The Graphical User Interface’s main components are described below. There are six views in the S-FRAME

interface. The Geometry Window or VIEW is opened, by default.

LOADS - Graphical input of loads; Joint Loads, Member Loads...etc.

SPREADSHEET - Numerical definition of model objects, properties, and loads

GRAPHICAL RESULTS - Post-analysis Graphical results; Deflection, Load Diagrams...etc.

CAD DETAILS - Graphical input of non-structural information — dimensions and offsets.

GEOMETRY - Graphical input of model objects and properties; joints, members, sections...etc.

NUMERICAL RESULTS - Post-analysis Numerical results; Deflections, Member Forces...etc.

B File Ed4 Vew Deite Seot Semngi Options Run Wiedsw Help

DEBS 2 YR@XDTHREOS - S trisBARE 290 VIEWS, GRIDS &
o - x[

& =2 s Load Mt

W

}_ DATA BAR

{Appearance depends on Active Tool)

GROUPS PANE
o med

madel organisain|
MODELING SPACE

GLOBAL ORIGIN
& AXES

MODELING
TOOLS

o
al
4%
2
-1
WINDOWS
EY STATUS BAR
== SHORTCUT {generaly information of feature quick ON/OFF)
! BAR
=y
! l W
BT TE TN T e T, Bo Bor on fov o mon g "o o Won v

Figure 10. The Graphical User Interface

a. The tools on the left-hand side are used to create, edit and view the geometry, the loads, and the

results.

b. Depending on the currently active tool, we have additional options in the Data Bar shown above.
Views, grids, coordinate systems, section and material properties can be edited in the Properties

Toolbar.
d. The switches in the Status Bar below allow us to hide/unhide information of our model.
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S-FRAME has numerous graphical navigation options, common to many modeling/drawing programs.

Mouse Navigation
The mouse can navigate quickly as follows:

e  ROTATE model - hold down right mouse button and drag (+Shift to rotate about Y-axis)

e ZOOM model - scroll the mouse wheel
e PAN model - hold down mouse wheel and drag

The model used to demonstrate S-FRAME’s navigation and selection tools is located in the default directory

C:/Users/Public/Documents/S-FRAME Software/S-FRAME/Tutorials/PART 1.TEL

If you want, you can open this model file to practice the navigation and selection options described below.

Toggling the “Shrink Elements” tool allows for easier selection.

- -
CxEé# LB >>»I+5 @0
o LT ®

o e e 0 P Bt §

r-|§ i
W
IE?

—
AREREADCH EESEE A - BN ]

Zoam

Options

Lom don fhon gon xin | FEr ST R He &

Figure 11. Mouse navigation

The Aerial Window provides quick access to many standard views and zoom/pan options and can be

repositioned anywhere within the GUI.

% Aenal Window

Top

Bottom

Left

Right

Front

Back

EW Isometric

SE Isometric

NE Isometric

2RPLEHE X

NW Isometric

2S5 o HED MY
E

|
s

==

=

Figure 12. The Aerial Window
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The Selection tool provides multiple ways to select or unselect objects in the viewport. This tool is common
to all graphical windows. Note also the existence of the Select Special dialog, which you can access from any

graphical window in S-FRAME.

D S-FRAME - <Untitled> - [GEOMETRY]
B3+ File Edit Mesh View Define Select Settings Options Run  Window Help

DeEdE @ sBRX Select > Al
| = Unselect > Joints
Ok n Joints 0 Members 0 Epeaialy Members

Unselect Special... Triangular Elements

] Quadrilateral Elements
Shorteuts > My Stucture Invert Selection

Triangular Diaphragms
Geometry tructure ) .
. | &rea Load Members Quadrilateral Diaphragms
i Panel Elements
1,

Ctrl+A

Figure 13. The selection Tool

e All OBJECTS such as Joints or Members are selected (active) by default and are indicated by solid

lines and filled circles.

e Unselected (inactive) objects are indicated by dashed lines and empty circles.

e Unselected (inactive) objects can optionally be hidden to simplify the view.

The SELECTION Tool k is Active by default. The selection tool is used to select/unselect objects.

BiFle B8 Meh View Defe Selet Semeg Opiors Fun Window Hep

Cedé 2 shRaxaI+ 500 LA T TR h &+ P I®®0
B T 2 sk B e N R = Mot bam
o oo 0 re— e P Po— .qf‘ 57 Trese Jotn 37 rctetn sonis <% et Soncten f¥

Sharus X My S xf

SELECT/UNSELECT
ALL

[

SELECTED

SELECTION Tool
Active

ARNSFDULDFHEFEEN AT - @HE N e ]

I
L

RURBED ¢

o | fon gon Slon Eor Wor o | P

Eo  Wor ior

w Won Low Lon @or dpor en §

UNSELECTED

Figure 14. Selected — Unselected Objects

Actions - such as Delete and Move — can only be performed on Selected objects.
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Standard Mouse Select Operations

S-FRAME provides numerous graphical ways to pick and unpick objects such as joints, members,
dimensions, 2D elements, panels and diaphragms. The meaning of "pick" and "unpick" depends on the
active tool.

There are five ways to pick (or unpick) as shown in Figures 13, 14, 15 and 16 below:

1. Single Click: While the Selection tool is active, click a joint, member or 2D object centroid to toggle the
object's selection status. You can also toggle the selection status of an object by right-clicking it and
choosing the appropriate command from the Viewport menu.

2. All objects properly inside a box: Drag the mouse from right to left.

3. All objects inside a box, including objects that intersect the box: Drag the mouse from left to right.
The application selects those objects that lie within or intersect the rectangle.

4. All objects that intersect a line. Hold the Shift key down while dragging the mouse across objectrs.
The application selects those objects that lie intersect the line drawn.

5. All objects properly within a polygon: Click the mouse in empty space to define each vertex of a
polygon—up to a maximum of 30. When you finish defining all of the vertices, click the first vertex
again. The application selects only those objects that lie entirely within the polygon. Be sure the “Pick all
Objects inside the Polygon” tool is selected.

e { Left to Right Mouse Button Drag ]

/ l‘\'o\\ ‘\"\_
| .
- !
i

L

=g

Figure 15. Select Objects
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| o
Aon g@ow [Fpeon | xon  Foon g |Eon | dBor ion ¥hon | fFon gRow [SHon | fHon

Figure 16. Select Objects inside a polygon

‘- loads.

Depending on the tool selected, these operations can be used to ASSIGN attributes and

Holding down the Ctrl key instructs S-FRAME to unpick rather than pick.

9 f+ Cirl Left to Right Mouse Button Drag_J

e ————————

+Ctrl Right to Left
“oq, e Mouse Button

‘\\‘ Drag

————— e

Ctrl + Shift Key + Mouse Drag

Line unpick using the
combination

Figure 17. Unselect objects.
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Figure 18. Unselect objects inside a polygon

The “Pick all Objects inside a Polygon” tool, located on the bottom toolbar, must be toggled on for the
polygon selection/unselection method to work.

;o . Depending on the tool selected, these operations can be used to ERASE attributes and
- loads.

A tutorial video demonstrating these features is available in our Online Resources

Help—>Online Resources—>S-FRAME Analysis Videos
The Model used in this demonstration is located in the default directory:

C:/Users/Public/Documents/S-FRAME Software/S-FRAME/Tutorials/PART 1.TEL.

J\ ALTAIR
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3.0 Geometry Window - Define Geometry

There are several different ways to define a structure’s geometry in S-FRAME Analysis

Regular Framework Command 0

You may have noticed that we can generate a Regular Framework (Figure 9. Model Generation Options). This
framework generation can be performed when we launch the program or afterwards by going to
Edit->Regular Framework

5 Edit Regular Framework »
Generate frame with regularly spaced bays... Ok |
Foldzr base name Cancel
™ Include ground floor members
Z - Storey Height Include Internal Elements
) Mone
2o o ! () Triangular Elements
Etilenufs () Quadrilateral Elements
al;irgeyﬁ oo " (® Beam Elements
X - direction Y - direction
¥ start ’gg— m Y sart ,gg— m
Mo. of Bays ’7 Mo. of Bays ,7
Bay width ’gg— m Bay Width ’gg— m oo

Figure 19. Edit Regular Framework dialog

You can find a tutorial video in the Online Resources
Help—>Online Resources—=>S-FRAME Analysis Documents

Define geometry using the Member Definition Tool.

If you want to practice using this tool and have previously opened the Part1.tel file, close it now by exiting
and re-opening S-FRAME Analysis, selecting the create New3D model option.

The Member Definition Tool is typically the most common way to define member geometry, but to define a
member this way, we first need to define a Grid set or a set of Joints.

O Grids

Grids are defined under the Define menu (Define = Grids) or by clicking the Edit Grids shortcut on the
Views, Grids and UCS toolbar near the top of the interface.

-] = B e o3 sk I = SIS - searTyes Bem
oh G Jees 0 s O sels 0 Feen ] Cuctragen 0 Tt Mamtars i Thoe Jorts, 47| icite Jomts <51 vert Seineten ok

Shoriuts X My Sinchas *

[l

TRl 0 dev Lot Manbas

- [

= Swmamn = §

=]
Bl

DS HEEAHEN AT FEHY N

Figure 20. Open the Grid Definition dialog
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S-FRAME comes with a set of default grids. If the default grids are not showing up in your dialogue, you can
open the .DGD file by clicking the ‘Open’ button, and the .dgd’ file should be in the folder that appears. You
can also create your grid by right-clicking on the None to select New Grid Set.

Once a Grid set is defined, members can be defined with the Member definition tool using the Two Joint
or the One Joint method, and clicking on intersecting grid points. To practice in S-FRAME Analysis, select the
“Equal Spacing 1m Grid”, making sure the “Display Grid” and “Lock Grid” boxes are checked, then “OK".

Zoom out to see the grid, or click on the ‘Zoom to grid extends’ in the Aerial Window.

B Grid Definitions

<

----------- ) Equal Spacing 1m Gr || Row Grids
-7 Equal Spacing Gm Gr
----------- [ Equal Spacing 11t Gri
----------- 1) Equal Spacing 10f G

0|00 |~ [T |0 (4= |0 (R | =
=1EEEEEEE R

=

> (|4

= Nurmn
Grids

sl
0|00 |~ [T |0 (4= |0 (R | = g

oo oo oo oo oo

[
=

Ll

@0y | |

m

[® Display grid
[%:iLock grds!

=2 |DDDDDDDDDE

X Laock joints ta grids
[T Set as default grid

UCS type
i+

.

Current Color

I

Lancel | Hew |

| Save Az, | Open... |

Help

Figure 21. The Grid Definition dialog

% Aerial Window

n\@»x

CEHHIDME R

BRpLHLE X

Zoom to grid extents

—FI=FI-F]

Figure 22. Zoom to grid extends
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Two Joint Method for defining members:

1. Activate the Member Definition Tool
2. Setthe Two Joints approach on the data bar above
3. Click OK to accept the settings
4. Toadd amember, click on two points where grid lines are intersecting
5. Locking the grid lines will prevent unintended changes to the geometry
o) = BAT | 48 Eosd Spocmy Im G . e B2 » (ZN 1 SeelUSLEAN]  « MemgerTypes Beam
o Two Joints One Joint £ Number of Lnks 1 Srart ol (31) O End et (J2) 0 Contnue frem last oint No = Jgints Oaky $4 Deta X 0 m
peras 0 r-< 4 h‘e
smte HySmme x| I o =
ieomety | [&] i
T (36 Sona Load Memibers
o
o
- O
»
S
T
u
5 -
& //'/ 2
.
¥ e
[
b e
(5] i
m /.'// e
: | ]
fae ey //"/
g ; ",_I“E;J,r'.
& % Aenal Window *x 1 |
o [} :
B a
- 1=
Loady
Graghed
W
CadOust | ModiOpwine B [ 5]
ot @ov whot oon Son Wow Low Lov @or dpon Ao oo [ Mo aon | HLon |[Mhoa | Blon gRow

Figure 23. Define a member in +X by defining a grid and using the two joints approach.

One Joint Method for defining members:

Select the One Joint option and note that the contents of
have the choice to specify the direction and the extrusion

the data bar are automatically updated. We now
method.

I I 1-Steel (IS &CAN]  + Member Types Beam

[+ x3Z v 2% xP v -z'@\ Specify Length «> Extrude To First »° Extrude To Last & Member Length O

=]

t

B - AR i vone e Y
Ok &2 Two Joints | One Joint % Number of Links 1
Jnints Onty %" \ 1
Shartcuts X My Shucture X |
Geametry clure
? rea Load Members = - - -
Specify the direction
@
o
&

fSpecwr,- the extrusion method _J

Figure 24. One joint options in the data bar.

1. Set the direction to positive Z axis, and
2. Select the option Specify length (if not already)
3.

Proprietary Information of Altair Engineering

Specify the member length, and click on a point of the Grid set to define the member
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Figure 25. Define a member in +Z by clicking on one point.

In S-FRAME Grids can be used to define and Edit the structures’ geometry. For more information
visitHelp>Online Resources—=>S-FRAME Analysis Documents

Joints

Joints are defined using the Joints Tool, and entering Joint Coordinates in the data bar above. The process of

adding joints, is as follows:

1. Select the Joints Tool

2. Enter the Joint coordinates

3. C(lick OKto add the joint

D& R iR X2IXEHOE 2o @-A8-#q

Shartcuts

y Structure

= R iR
o) - a8 i Nore -8 ®
Ok {.X-Cnnrdinate ] m Y - Coordinate 1 m Z- Coordinate [ m
Distandg From Joint | To Joint | | Zoom Extents. @

Figure 26. Add joints

Once ajoint or a set of joints are defined, members can be added using the one or the two joints approach.
Joints can also be added via the Joints Spreadsheet (imported from Excel™). This topic is discussed in greater
detail in the following chapters.

Proprietary Information of Altair Engineering
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2D Elements

The Panel Element Tool acts similar to the Member Definition Tool and is used to add Diaphragms, Panels,
and 2D elements. The panels can be of any shape and have up to 30 points.

[ raneitemen |

el 1 +
flge Deasnraze

=l
=
=
=
[
|
]
[ |
-
[ |
|
|
=]
| =}
[
||

S

Comg

Figure 27. Panel Element

The available panel elements and their properties are listed below:

1. Hole: A hole panel within a larger panel instructs S-FRAME to ignore the hole area for diaphragm
masses, mesh conversion and area loads.

2. Rigid Diaphragms: Used to assign constraints (X, Y translation and Z rotation) to a set of joints which fall

in the same plane.

General Diaphragms: Used to assign constraints to all joints which fall in the same plane

Membranes (Triangular or Quadrilateral Mesh): Provide in plane Stiffness only.

Plates (Triangular or Quadrilateral Mesh): Provide out of plane stiffness only.

Shells (Triangular or Quadrilateral Mesh): Provide both in and out of plane stiffness.

o v AW

Membrane, Plate, and Shell elements are automatically meshed using S-FRAME's auto-meshing
algorithm.

In addition, 2D elements can be defined using the Quadrilateral IEI or the Triangular |£| element tool.

Import DXF Files O

It is possible to define geometry by importing an existing DXF file. Please review the DXF Import
video, available in Help—>Online Resources—>S-FRAME Analysis Documents

Import a Revit™ Model O

It is possible to define geometry by importing an existing Revit™ Model file. Please review the Revit™ Link,
video available in Help—>Online Resources—>S-FRAME Analysis Documents

Import a Tekla™ Model 0

It is possible to define geometry by importing an existing Tekla™ Model file. Please review the Tekla™ Link
video, available in Help>Online Resources—>S-FRAME Analysis Documents

J\ ALTAIR
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Defining Section Properties

Section Properties are defined using the Section Properties Tool (not the button on the top toolbar). Right-
clicking to the tool brings up the Section Properties Tool dialog box.

o File Edit Mesh

Ok a# Members 0

Shoiteus X My Stuctuie

Geomety

A BEABDENDFHE S € o - fEHW w0, %, 0 B

View Define Select Settings

DEzE& 2 sBEaX DI K
- B8

Options  Run

Window  Help

-8 -#

23 &
e I

~ Hide Section Numbers g* Generate Folders [

kLR ®

+ IE 1.-Sieel(USRCAN] - MemberTypes Beam

1@@®0.-

‘Section Properties

£ Section Properties Tool
File

Editlocal section database

Close

Section Name

Current Section

Plastic section moduli

2 3
22 3

Mz@ﬂ |
¥

323 [LEL)
Shress Pls

N

Current Color

B Other

Product of Inetia lyz

[ Hide Section Mumbers

[ Exponential Format

Inetia (1) e
Inettia (2) mmé
Torsion Constant e

Sheartiealy) [ mm2

Shearteald [ mm2

Gossteal [ mm2
SwessPanmizl) [ mm
Stress Faint 1]
Stress Pt (22]
Stress Paint 2]
Stress Pt (23]
Stress Paint 3]
Stress Pt 24]
Stress Paint 4]

Cancel

flil

Update

(3

dd

Delete

Steel

Concrete

Shapes

i

d

Help

Figure 28. Section Properties Tool Dialog

Selecting the type of the section (Steel, Concrete or Shapes) brings up additional dialogs, where you can Edit
the sections before they are added to your model.

When defining Steel sections, you have access to several international Steel database tables.

Proprietary Information of Altair Engineering

O kErnH

|

Toggle Units

53 Steel Section Properties

Section Marme:

Steel Table:

IPESODA

8,00 3.300

E—
A A —

e
46.00

R

European -
American [AISC)
Britich
E European
AlJapanese
5 Australian
| AISC 2011 US
-l AISC 2011 US - misc ¥
X TO.J07 10
x 31.78 mm
Zx 16.51; 10°3 mm3
Iy 0.0685: 10”6 mm4
5y 4.6924: 10°3 mm3
w 10.37 mm
Zy 2.9794: 10”3 mm3
J 3.9299: 103 mm4
Cw 0.0933; 10”9 mmb6
k1 0 mm
k 9.2000 mm
Cost 0:  $/tonne

List of sections to add to local database

‘

Help

Figure 29. Steel Section Properties
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Concrete sections can be defined using the S-CONCRETE Visual Editor. Users need an S-CONCRETE license
and the Integrated Concrete Design (ICD) feature enabled in order to define concrete sections. If enabled,
you can code check and design your entire concrete structure according to your specified international

concrete design code.

The example at the end of this guide includes concrete section definition and detailing.

ﬁ 5-CONCRETE Visual Editor

File Edit View Run Results Settings Help

[Tl ] [@m] | m]=e]

[ Fectangular Beam

Sestion Name [Concrete Section

Job ¥ [4123.45

W ‘isual Editar

O | &SR alalaladsl Tos%a me @22 ¢ Add o]
B|F| LB [Gtatus = Unacceptable | W& TUH=046 | Hyvs M UG =1.07

Material Properties
fc'=35MPa
fy (main) = 400.0 MPa
fy (stir) = 400.0 MPa
We = 2400 kg/m3
Ws = 7850 kg/m3
Poisson's Ratio = 0.2
hagg = 20 mm

Es = 200000 MPa
Ec = 28165 MPa

Ge = 11735 MPa

Section Proj

Zbar = 300 mm

Ybar =0 mm

Ag = 300000 mm2

Ig (y-y) = 9000.0xEE mm4
Ig (z-z) = 6250.0xE6 mm4
Ashear (Y) = 250000 mm2
Ashear (Z) = 250000 mm2
Jg = 12459xE6 mm4

Ae = 300000 mm2

le (y-y) = 9000.0xEE mm4
le (z-z) = 6250.0xE6 mm4
Ase (Y) = 250000 mm2
Ase (Z) = 250000 mm?2
Je = 12459xE6 mm4

X,

[ Stimups |
Y12 @ 200 mm

Top Bars  []

2Y25 + 3Y25

[Bottom Bars []
2Y25 +2Y25

[ FaceSteel [x]
4Y16 @ 180 mm

] L
600
. L
«_°o o o
Summary

Concrete Section

Job #A123.45

CSA-A23.3-94 Standard

S 500

S-FRAME
Moustafa Zoumpre

Shear / Torsion Results

Viz =1250kN
Vfy = 35.0kN
Vfz /Vrz =0.348
Viy /Vry = 0.108

Avz/S (req'd) = 0.00 mm
Avy/S (req'd) = 0.00 mm
S (req'd) = 200.0 mm

Miscellaneous
Quantities (Approx.)
Concrete = 707 kg/m
Steel = 49.1 kg/m

Top Bars

d' =65mm

As' = 2455 mm2
As'/bh = 0.00818
dz =™ NJA™
Bottom Bars

d =536 mm

As = 1964 mm2
As/bh = 0.00655
dz = ** NIA™
Face Steel

As =804 mm2
Clear Cover

Top = 40 mm
Bottom = 40 mm
Side = 40 mm

Flexural / Axial Results

NF=-300.0 kN
Theta = 75 Degrees
Mf = 414.8 kNm

Ir = 389.4 kNm

Figure 30. Concrete Section using S-CONCRETE’s Visual Editor

Once concrete sections are defined, they are displayed in the Legend. The Active section is shown in Bold
Text. Right-clicking on the on the colour box for each section changes the display colour. Left-click on the
colour box sets the ACTIVE section.

Proprietary Information of Altair Engineering
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Figure 31. The Legend
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Define Material Properties g

Material properties are defined using the Material Properties Tool, located on the left-hand side Geometry
View'’s modeling tool list. Left-clicking on the Material Properties Tool opens the Legend with the default
material properties. Right-clicking this tool opens the Material Properties Tool dialog, shown below, where
you can modify the existing materials and Add new.

Material Properties & Material Properties Tool
Il 1 - teel (US & CAN) File

Il = - Steel (BS5950)

I = - Steel (EC3)

- 4 - Nominal Concrete (ST)

Edit local material database Cloze

PR

Cancel
Il - - Mominal Concrete (MT)
4 Update
Il & - Concrete 35MPa (CSA-04) Mateiiol Mame — ) ) =
- 7 _ Concrete CI5(BSBMD) [ Hide Material Numbers
)& -Auminum 6061-T6 Funent Material [~ Exponertial Fomnat
[ ]9 - Aluminium (B58118) — Delets
. Steel [US & CAN) ~ Youngs Modulus (E] W2 —
Il 10 - cast iron (Malleable) Steel [BS5950)
[ 17 - Cast Iron (Gray 4.5%C ASTM A48) Steel [EC3)
i . § Nominal Concrete [ST) Shear Modulus [G) Némm2
- 12 - Wrought iron (UK} Mominal Concrete [MT)
- 13 - Douglas Fir Concrete 35MPa [CSA-D4)
-oeug Concrete C35(B58110) Force Density M/mm3
I 14 - Timber C16 (BS5268) Aluminum 6061-T6
Aluminium [B58118)
Cast Iron [Malleable) Current Color p-s -«
Cast Iron [Gray 4.52C AST Temp Coefficient /C*1.0E+E
Wrought il_nn [UK) \i‘
Douglas Fir v Yield stress [Fy) MN/mm2

f

Help

Figure 32. Material Properties

S-FRAME comes with a default material library. If this library is not showing up in your dialogue, you can
open the .DMP file by clicking the ‘Merge’ button, and the ".dmp’ file should be in the folder that appears.

Once the definition of the Section and Material Properties is complete, these properties are

7-.6 | available to you in the combo boxes on the Views, Grids, and Properties Toolbar.
;I 1-1PE 200 - _I-_l 1-5Steel (US & CAM] = Member Types Beam -
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Supports Tool

Supports are defined using the Supports Tool, located on the Geometry View’s modeling tool list.

Left-clicking the Support Tool to edit the support conditions and assigning the constraints in the Data bar
at the top of the GUI (figure 29).

Right-click on the tool to bring up the associated dialog (figure 30). These constraints can be then applied to
the selected support joints, by simply re-selecting them using the standard mouse selection options.

DEeEH& ® s2RaX2T+XEC
(5] - B i8 | Hi None - B
Ok & Joints D ER P |

Shaorteuts > My Stucture X

Geomety

Area Load Members

HA4 %% % ¢ B

=B
=

]

Figure 33. Assign constraints in the data bar

B3 Support Tool *

Festrain joint degrees of freedom...

Translation - fixed in: Display support options ﬂ
[% 3 - global trarslation ili
[* ¥ - global translatian !~!
[% Z - global tranzlation | [

¥ X [ [

Current Color

2.

Botation - fixed about:

[% - global rakation

Other...
[® ' - global ratation \i—‘
[® Z - global rotation Help

Figure 34. Assign constraints in the Support Tool dialog

We can also assign defaults constraints to all joints of a model, by going to Settings—> Default Constraints.
Assigning default constraints is useful if you want to simplify a 3D model into a 2D problem (2D constraints).
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B Default Constraints b4
Settings  Options  Run Window

Units... Default Constrained Degrees of Freedom
Analysis Type... Corcel
Default Constraints... Constrained Directions
Project Description... [ ¥ - Translation
' - Tranglati

Model Type... |— ranslation

[ Z - Translation
Preferences...

[ - Ratation

[ * - Rotation

[ Z - Rotation

Help

Figure 35. Assign Default Constraints to all Joints of a model

E E3
S-FRAME also supports Linear springs 27! and Non-Linear springs 77! . These support conditions are
edited and defined in a similar way to the above.

4.0 Loads Window - Define Loads @

Loads are defined through the Loads Window. Click Loads on the Window shortcuts below the Geometry
tools to switch to the Loads window. (be sure all open dialogs are closed first) All the modeling tools are now
replaced with load-type tools.

s @ ] -
ﬂ e % ag fdv?:
Ok &/ Joints 0 Members 0 Shells 0 Panelz 0
Shortcuts >0 My Structure x
Geometry 3‘— w
H Area Load Members

N

#

+

f Load Types

;: ot

9’6 - Settlement

& -Thermal Member

}, - Concentrated

I Giobal

[l Giobal Frojected

[ Local

4 Il Thermal Shel

=

= - Pressure

- -Areﬁ Loads

o

=

Figure 36. Load Types

In addition to the displayed Load Types in the Legend of the above figure, you can also define Response
Spectrum Curves, Time History Loads, Moving Loads, Prestressed Tendon Loads, and Non-Linear Quasi Static
Loads.
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Similar to the Geometry Tools, Right-clicking on a Load tool symbol opens a dialog box to define the specific
loading condition. Left-clicking on a Load tool allows the user to edit the loading condition through the

data bar above.

Ok & Joints 0

Geometry .-';

m"g%\;ﬂﬁ»gﬁ

- %a? it Equal Spacing Tm Grids + i

| Direction | - Force - | Magnitude 0.

kN | Scale Load Mo

Shortcuts >0 My Structure

3 &rea Load Members

D@ dE 2 a2+l o | d-A-Ae Q4%

A
-tk B

X

Load Types

Il Joint
- Settlement

- Thermal Member

- Concentrated

Figure 37. Define Joint Loads through the data bar
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Edit Projected Loads Ok I
[ Eull or Partial options Cancel

© Fulluriformly distiibuted load (.
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Figure 38. Define Global Projected Load through the Global Projected Load Tool dialog

Proprietary Information of Altair Engineering

J\ ALTAIR



Altair S-FRAME 2021.1
Quick Start Guide

p. 24

Define a Load Case

A load case is a convenient way to organize a structure’s loading. Each load case has a number and
description. Load cases are defined through the Edit menu, or by clicking the New Load case shortcut in the

View, Grids, Properties toolbar.

Delete Leads...

Load Status...

New Load Case...

Open Load Case...

Save Load Case As...

Load Combinations...

Groups

Convert Area Loads to Member Loads
Generate Noticnal Loads...

Construction Stage Status And Preloads...
Generate Equivalent Static Loads from RSA Case...

Generate Open Structure Wind Loads...

Tool...

Edit View Define Select Settings Opticns Run  Window Help

F"@'Mazﬂ%@’!& kLE & P dlllaas 2 2EM.
c kP ==
Z - Global ~ Absolute or Belative Relative - w1 0 kN/m Scale Load Mo -
\
. New Load Case
Shortcut

Ctrl+T

Figure 39. Define New Load Case

In the New Load Case dialog box, you define the name, the gravitational factors and the scale factor.

[ Mew Load Casze

Defing Mew Load Case Narme and Factors

Load Caze Description:

Load Caze Mumber 1

i

|| LCancel

S

"Elavilalional Factors

Load Type: Static

Scale I 1 Current Case

Help |

Figure 40. Edit New Load Case

weight of the structure.

Assigning a gravitational factor of -1' in the Z direction instructs S-FRAME to calculate the self-
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Define a Load Combination

A load combination allows the user to factor and combine different load case results. A load combination
typically uses factors recommended by an engineering code. Load combinations are defined through the
Edit menu in the Loads Window or through the loads Spreadsheet in the Spreadsheets Window (the
Spreadsheets Window gives more space than the Edit Menu option).

Edit View Define Select Settings Options Run Window | [ Edit Load Combinations x
Delete Loads...
Load Status... Selected Object Number Ok |
New Load Case... o Step |1 Increment |0 Fomat..
Open Load Case... - - - =
Comb Comb Active Status MNotional MNotional L+
Save Load Case As... No Description 0=Yes,1=No X-Factor ¥-Factor C Dielete
Load Combinations... 1 Load Comb 1 ves j 0 0
Groups > Sort
Convert Area Loads to Member Loads
Generate Notional Loads...
Construction Stage Status And Preloads...
Generate Equivalent Static Loads from RSA Case...
Generate Open Structure Wind Loads...
Tool... Ctrl+T
|
Hel
o | v [ Help

Figure 41. Edit Load Combinations within the Loads Window

5.0 Spreadsheets Window ©@

An alternative way to edit the structure’s Geometry and Loading is via the Spreadsheet View. Click
Spreadsheets on the Window shortcuts to maximize the window.

Within this window, you can modify the structural attributes. Any changes applied here update
automatically in your model. The spreadsheets function similar to Microsoft Excel™. You can copy and paste
cells, change the size and/or export this information to an Excel spreadsheet, modify and import it back into

5 File Edit View Search Format Settings Options Run Window Help
D=zE& % BE X & 2 R M-
= [1- =&
[Load Comt 7 sep 1 Increment |0
[ View Groups X Replace numerical codes with detailed diop down combo boxes
Shertedts X My Stucture X | comd Comb Active Status Notional Notional Load Ccomb Load Comb Load
Geomety =1 No Description 0=Yes,1=No X-Factor Y-Factor Case Factor Case Factor Case
Area Load Members 1 Load Comb 1 Yes. 0 0 )] o hd
Ceacy 2 |Load Comb2 Yes 0 0 0 0 ~]
Giraphical 3 |Load Comb3 Yes 0 0 0 0 ~]
Spreadsh I 4 |Load Comb 4 Yes 0 0 0 o ~]
5 Load Comb 5 es 0 0 0 ] hd
e . & |Load Comb6 Yes 0 0 0 o ~]
i Switch between 7 [Lomacombr  Jves 0 0 0 0 -
+
: the Geometry
g and the Loads
“ Window
£
a
= ™ Load
B2 | Combinations Tab

Figure 42. Edit Load Combinations within the Spreadsheets Window

P Tutorial videos which demonstrate these features are available in the Online Resources
Help—>Online Resources—>S-FRAME Analysis Documents

J\ ALTAIR

Proprietary Information of Altair Engineering



Altair S-FRAME 2021.1
Quick Start Guide

p. 26

In S-FRAME, you can also Import/Export data from/to a Microsoft Access™ Database. This data
exchange is done by going to File>Import/Export->Access MDB in the Geometry Window.

) S-FRAME - <Untitled> - [GEOMETRY]

C New...
| &) Open...
= O = 0 Merge...
- Save
Save As..
She
G Import
Export

Print Preview...

Update Geometry...

Integrity Checks...

E5- File Edit Mesh View Define Select Settings Optiens Run  Window Help

8 ¥ R ®
-tk I

i Two Members i@ Three Joints

> Access MDE...
DXF...
ETABS...
STAAD..

6.0 Graphical Results Window ©

After an analysis is performed on the structure, the Graphical results window becomes active. Similar to the
other windows, on the left-hand side we have a set of tools to view the results graphically.
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Deflections

Reactions

Axial Force Diagram

Shear Force Diagram

Moment Diagram

Torsion Diagram

Member Stress

Membrane Forces

Shell Shear

Plate Bending

Shell Torsion

Shell Contours

Slab Design Contours

Strip Beam Integration Line Forces
Wall Forces

Result for Wall Line assembly with the same pier no
Mode Shapes

Buckling

Influence Line Diagrams

Free body forces

Pass Through Forces Tool

Figure 43. Tools in Graphical Results Window

Depending on which tool is active, we have additional options shown in the data bar above, to specify the

results to be displayed.

heEd& 2 & W-G-Aa2kehk hRkE ®| P = %
[&] - B8 i i 4
| EEXy
Ok w Load List Fange ~ Load Case [ Which Section? All Sections ~ Stations § ~ Which Type? Al Types
I ¥ Moment g z Moment T;g Max gg* Min gg Max +Min gy ABS(Max) gy ABS(Min} gy ABS(Max) + ABS(Min) wlRutateT&x‘t “;.)

Figure 44.Additional Options to display results
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i

A Tutorial video that demonstrating these features is available in the Online Resources
Help—>Online Resources—>S-FRAME Analysis Documents

7.0 Numerical Results Window ©

Results can also be reviewed in a Spreadsheet view, where we can create tables with specific results, and
print or export these tables to Microsoft Word™. Click on Numerical Results on windows shortcuts to
maximize the window. We can print tables for the following results:

&z

+¥

P

iy
b
e
i
it

[®]

T

i 0] D ey

Joint Displacements

Reactions

Member Forces

Member Normal Stress

Member Shear Stress

Shell Forces

Shell Stresses

Base shears, Overturning Moments and Center of Gravity
Wall Forces

Inter Story Joint drift

Floor forces, Storey Shears and Overturning moments
Result for Wall Line assembly with same pier no

Strip Beam Integration Line Forces
Results for Connection Design Pass Through Forces

Figure 45. Numerical Results

To generate reports click the Print shortcut or go to File>Print within the Numerical results window. Specify
the properties and the results of interest in the Print Reports dialog, and print the desired results.

5. Print Reports *
iGeneral: T Project Titles T Geometry nput T Load Input T Results T Repoit Files
Margins Printer Setup...
Left Margin [T Right Margin [ in a—
ommat...
Tap Margin 05 Battom Margin 05 in
Fonts...
Start Page [i] End Page 0 g
Print Options

[X Print Row Header
[X Print Column Header
[% Print Grid

[% Print Border

[% Print Color

[% Print Shadows

% Print Page Numbers
[~ Frint Date and Time

Current Printer Font and Size
Arial

Regular, 8 pts

Frint Preview. ‘ Frint ‘ LCancel | Apply ‘ Help

Figure 46. Print Reports dialog

i

A Tutorial video demonstrating these features is available in the Online Resources
Help—>Online Resources—>S-FRAME Analysis Documents
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8.0 CAD Details

In S-FRAME Analysis you can add dimensions to your structure, and include them in the printed reports
through the CAD details window. Once you add the desired dimensions, you can then switch to the
Geometry, Loads or Graphical results window and display the defined dimensions by switching to ON the
Display Dimension Information option in the status bar below.

Ao ghor | Hon woforr S off

Figure 47. Dimension Information switch

Cardinal Offsets adjustments, which can be done from the CAD Details window, lets you specify non-
structural offsets for members so that S-FRAME can render them more realistically. You can, for example,
align the top of steel for floor beams—of varying depth—so that the top edges are coplanar.

Ok 8/ Members 0 1 X etz X p3 X ree Tlps = e L 7 I pta X et L

Hide Cardinal Numbers gy Pt Offsetiny’ 0 m Pt Offgetin'z’ 0 m

Figure 48. Cardinal Offsets

. You can find useful information for the Cardinal Offsets, in S-FRAME’s Help System (Help >
Contents - ‘Search Tab') under the ‘Cardinal Points’ topic.
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9.0 Example

Below is a simple example designed to present many of the features discussed in the preceding pages. You
may need to refer back to earlier sections in order to complete this example.

In this example we build a hypothetical 3 storey structure using the Regular Framework command and the
Member definition tool. We then define section and material properties, support conditions and run an
analysis.

Define Geometry.

Open S-FRAME Analysis if not already open (chapter 1.0 First Steps, page 6 ) and from the New Structure
dialog select the second option: Create a Regular Frame Work.

If S-FRAME is already open, Go to File—> Regular Framework, to bring up the Edit Regular Framework
dialog.

Use the Regular Framework command to build the first two floors of our structure, where each floor is 3m
high, with 2 bays of 5m in one direction (X), and 3 bays of 4m in the other direction (Y). We also want to keep
the UCS at the centre of the structure, and this is done by entering the appropriate X and Y start coordinates.
Once you enter the input as shown below, click OK.

0 S-FRAME - <Untitled= - [GEOMETRY] B Edit Regular Framework X
B3+ File Edit Mesh View Define Select Settings |
0 T Alte Bhsp Generate frame with regularly spaced bays... Ok I
6] Redo Ctrl+Y Folder base name iLeveI Cancel
ok &/ Cut Cirl+X
Copy Cirle C ™ Include ground floor members
Shorteuts (=i EHH Z - Storey Height Include Intemnal Elements
Geomet, — ) None
Move... Ctrl+M Z start 00 m
i Subdivide... Moot > O Triangular Elements
;’B Construction Plane... Ctrl+B storeys O Quadiilateral Elements
Save Coordinate System... Stor m
o B He;:: 3 (® Beam Elements
& Regular Framewaork...
S Truss Generatar J X - direction ¥ - direction
ir Analytical Model »
I Groups > X start 5 m Y start 6 m
Il
- Start Numbers... Ctrl+5
u No. of Bays [2 No. of Bays [3
i Toal... CtrlsT
i3 I I BayWidth |5 m Bay'Width |4 m
Help

Example Figure 1.

A Any model generation or editing (translate, rotate, reflect, shear, scale...etc.) is always performed
relative to the current UCS.
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Based to the above information S-FRAME builds the model, and your structure should appear. Note the

folders that are created for the structural objects of each level.
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Example Figure 2.

2. Next, we define the 3" storey using the Member definition tool. There are numerous approaches available
for defining members using this tool, as we have already seen in Chapter 3 “Define geometry using the

Member Definition Tool”. First add additional members using the “one joint” approach:

Define a member using the one joint approach.

Click on the One Joint option on the data bar
Specify the Direction of the member, in this case +Z

®on o

Define the Member Length, in this case 3 m

Select the Specify Length option for the extrusion method

Select the Member definition tool from the tool bar on the left-hand side

(5] - B 2% ore

4
B

icd -tk I

Joints Only "

» | IB 1-Steel[USHCAN) = Member Types Deam

0k &/ Two Joints /[ One Joint ] Number of Links 1 X3P ey 22 ¥ -x 4P -v P -z 4| seecity Lengtn ] Extrude ToFirst »° Extrude To Last | Member Lengtn 3 m

Shottouts X My Structure x

Geamely | 2o My Structure
| o[58 Ares Load Members
L] Level 1 Beams
[ Level 2 Beams
] Level 3 Beams

®
\ L] Level 1 Columns
&

B

[ Level 2 Calumns

s,

Example Figure 3.

Now that we have specified the member definition properties, we can add a 3m long members in the +Z
direction by clicking selected (active) joints. We can select one joint at a time to add one member, or select

multiple joints at a time to add multiple members.

The screenshot below demonstrates the single and the multi-select options we can use to pick Selected

(active) joints and define the connected members.
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Add nine additional 3 meter members (columns) to your structure, in the positive Z direction using the three
different methods shown in the image below.

o « B8 i} tone .l sl T B0 o+ ZN 1-GeelUSLCAN] v emeerTypes Beam -
Ok G Twe Jonts o-emuz‘_ Wumber of Links 1 WP o BT x P v P -2 P Seecty Longin A Baruse ToFem 4* Braruge To Lawt /
Joints Onty 9 ( *
Shodouts X My Shuchae x -
Geomeny chi
il 2 Fves Losd Hembet:
T Level | Beama
) Lavel 2 Bearra

0 Level 2 Dearma

20 Lavel 1 Cohurrrat T T
) Lavel 2 Cohurtra 2. Shift + Left button drag. Members
) Rl will be added fo any interse 1 -

AWMDENDIHBEEEN AW -3 H‘H"i"-\‘_,“. s fpr

=
=4
@ -
#
@
v
| Losdy -
Graghacel ©
Soeedth | || —
Musnoscal
CadDetsls | Modd Digorizer | 1 [ ﬂ‘:l
om | @ott smoit eon Son WMon Low Low @on dpon Hon ¢ { Eon | Won o [Fon [Bon | Mow gow »

Example Figure 4.

After creating the nine additional members (columns) the next step is to create our model’s third story by
adding additional members (beams) in the X-Y plane, as shown in Example Figure 9

Define a member using the two joints approach.

a. Choose the Member definition tool from the toolbar on the left-hand side
b. ii. Click on the Two Joints option on the data bar
c. iii. Define a member by selecting two joints, as shown in Example Figure 5

Note that the Number of Links is set to 1. This setting is used to introduce joints (nodes) along the length of

a member. When the number of the links is 1, S-FRAME does not add additional nodes and the modelled
member has only its Start and End joints.

J\ ALTAIR



Altair S-FRAME 2021.1
Quick Start Guide p. 32
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Example Figure 5.

Adding additional nodes along the length of a member is necessary in some cases, such as:

: e Define ajoint load on a member
j_O'? e Getresults at a specific point of a member
= e Use smaller elements to represent a long single element
e Represent complex deflected shapes or mode shapes
e Connect additional members to a member.

We will now add another member, ensuring that we connect additional members (columns) to the new
member (beam)

Change the “Number of Links” setting to “2"” and create the additional member by clicking on the points as
shown below (1 and 2). S-FRAME builds a 10m long beam using two 5m long beams. This method ensures
that the beam and the intersecting column are connected at the additional joint located at the beam
elements’ mid-span. Please note that this is the case here because the column is located at the mid-span
of the beam element we added.

J\ ALTAIR
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Example Figure 6.

Clicking the “Shrink Elements” icon will change the display to easily view which members are connected to
which joints (nodes).

I Member is not connected to middle node (joint) I Member is connected to middle node (joint)

Example Figure 7.
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resulting new member.

To subdivide an existing member into two members, first select the Member Definition Tool and
then click anywhere on the member where a join does not exist, to open the Subdivide
Connecting Member dialog. Here you can specify the exact connecting location and the

5 Subdivide Connecting Member

Connect To Existing Member...

Member i

Length= 3.000 m

" Distance from start ' node

1 &t quarter point

1 st mid poink

1 &t three quarter point

) At a distance from ' node

@ At the last distance from ' node

) At a % distance from "' node

ARt

O At shortest distance to member

At the last distance from ‘1" node ™ |
[E m

_ Loed |

LCancel

Help |

The number of links is also available when using the one joint approach. Note the additional extrusion

options and define a member as shown below.

Another member creation option that utilizes the “Number of Links” option is to the use the one joint
approach combined with the “Extrude to Last” option. Select the Member definition tool, set the number of
links to 2, the direction +X and click on “Extrude to Last” as shown in Example Figure 8. Selecting the join

labelled #1 will create members shown in example figure 8.
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Example Figure 8.
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Finish connecting the 3rd-floor members (columns) using any of the above methods so that your model

looks like Example Figure 9.

create a new joint (node) that defines the roof's peak.

Once the 4" level members (beams) are added, the next step is to add a roof to our structure. We will first

Select the Joint Tool and add a joint at location (0, 2, 12) by entering the desired coordinates in the data bar

below and clicking OK.
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Example Figure 9.
Using the Two joint approach define the roof beams as shown below.
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Example Figure 10.

5. Next, we create a folder which includes our roof beams only.
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Quick Start Guide
a. Unselect all objects using the Unselect All shortcut
b. Make sure that the ‘Hide Unselected Objects’ option is not set, by switching to Off the appropriate
switch in the Status Bar below.
c. Goto Select>Special.
d. From the Select Special dialog, select the Diagonals option and click OK.
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Example Figure 11.
e. Right-click on ‘My Structure’ and Select New Group from the pop-up menu.
f. A group is created. Edit its name if you wish, then right-click the group folder and select ‘Update
Selected Group’ from the pop-up menu.
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Example Figure 12.
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We have now created a group, which contains our roof beams. S-FRAME's folder technology is a powerful
way to isolate objects and make editing objects easier as demonstrated next.

6. Next, we define Section Properties.
a. Right-Click on the Section Properties Tool to bring up the associated dialog, and select Concrete (this
can only be accessed if you have an S-CONCRETE and an ICD license). Alternatively, create a custom or
tapered shape. The tapered shape shows up in the renderings.
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Example Figure 13.

b. Inthe S-CONCRETE’s Visual Editor you can define and edit concrete sections. Section and reinforcing
properties can be edited under the Edit menu, or graphically as shown below. Add a 250x500 beam
column section by selecting the appropriate section type on the left-hand side, edit their dimensions,
reinforcing, name and click the Add button.

S-COMCRETE Visual Editar - 8] x
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Example Figure 14.
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For this example, it is worth noting that S-FRAME Analysis only takes into account the Section Properties:
the dimensions and the material. If your bar names and stirrups do not display as shown in Example Figure
14, you can set the following options:

Go to Edit—>Section and select British for Bar Type

T Section
Beams
Dimensions
Beam'width(b) [250  mm
Beam Depth [h] ISDﬂi i
Clear Cover
Top '40— mm
Battom ’40— i
Side 40 mm
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[v Crack Control (Top & Bat)
[v Crack Contral [Face Steel)

Crack \Width Lirit

0.3 mim

Effective Depth Limit
v Apply [d = 08h]

Z
h s
c.o
7l; ] ﬁl‘

Effective Section Properties Miscellaneous
le= i xlg Units  [Meric <]
se= |1 ¥ 4g Code  [EC2 2004 /OFLT
Ase= |1 « fshear | Bar Typel Biritish =
Ce= [i % Cg Mar: Utiiza{American

v W ariabl Eanadlan
Liztanm

Cancel

:

Help

Example Figure 15.

Go to Edit->Reinforcing and select the closed option under the Stirrup data.
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Example Figure 16.

c. Repeat this process to add a 500x500 concrete column section. Choose the “Rectangular Column”
section type from the list of selection types on the left-hand side, change the dimensions to 500x500,
provide a section name, and click the Add button.
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We could define sections using Custom or Tapered sections. However, when we define a
section using S-CONCRETE's Visual Editor, the Editor automatically calculates the required
section properties necessary for the analysis to run and creates additional files that include
information needed to perform both a code check and a design of our structure.

For those of you who do not have access to ICD (Integrated Concrete Design), the next steps describe how
to use the Custom or Tapered option to define the concrete beam and column sections previously created

using ICD.

We will define the sections using the Shapes option. Click on this option to bring up the associated dialog

box.

[} Section Properties To
File
Editlocal section database Clase
— — Cancel
ELTIALELC % Hide Section Numbers
Canent Section [ Exponertial Format %
Izt ] &4
Inertia (2] mmd. Delste
Torsion Constant mmd
Stesl
Shear Area (u) mm2
Current Color Shear Area () mm2 Concrete
B Ot Gross Area [¥] mm2 F—
Plastic section moduli Stress Paint 21 i
[ m Stress Paint (y1) mm
2 E—— Stress Point (22) mm
Stress Point (42) mm
(v2.22) 3 1.21) Shress Point (23) mm
Stress Point (43) mm
¥
Stress Point (24) mm
b323) 424 Stiess Paint (v4) mm
Stiess Pts
Product of Ineria lyz mmd Help

Example Figure 17.

Note that in the Linearly Tapered Section dialog box, you can specify whether the section will be Uniform
or Tapered. Select the Uniform option, and click on the rectangular section below, to bring up the

Rectangular Sections dialog box and define the dimensions of the section.

[59 Linearly Tapered Section

Edittapered section dimensions

Section Name L niform 1

Section Type

" Tapered

Edit Dimensions

@ Edit section at 'Start Made'

(C) Edit section at 'End Made'

fres

Properties at 'Start Mode'

Inertia [v) lﬂﬂi mmd

Inertia (2] lﬂﬂi mmd

Torsion Constant lﬂﬂi mmrnd

Shear Area [y] lﬂﬂi mmz

Shear Area (2] lﬂﬂi mmz

Grozs Area [x] lﬂﬂi mmz
Properties at 'End Node'

Inertia [v) lﬂﬂi mmd

Inertia (2] lﬂﬂi mmd

Torsion Constant lﬂﬂi mmrnd

Shear Area [y] lﬂﬂi mmz

Shear Area (2] lﬂﬂi mmz

Grozs Area [x] lﬂﬂi mmz

LCancel

Jal

Clear

Help

i

Example Figure 18.
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B3 Rectangular Sectiens

500 i

Lancel

3

Example Figure 19.

p. 40

Once the dimensions have been defined, click OK and note the calculated section properties of the section.
You can now edit the name, and click the Add button to add the new section to your sections library.

[59 Linearly Tapered Section

Edittapered section dimensions

X
Add

Section Mame

Section Type

* Unifarm

" Tapered

|Beam 250x500]

Edit Dimensions

@ Edit section at 'Start Made'

(C) Edit section at 'End Made'

Im

[a]
TL®

o

LCancel

|| Properties at ‘Start Node®

Inertia [y) |2604166666.66667 mmd

Inertia [2) 'm mmrnd

Torsion Constant 1817708333.33333 rimd
Shear &rea [v) 'm mma
Shear &rea [z) 'm mma
Grozs Area [x] W mmz

Properties at 'End Node'

Inertia [y) |2604166666.66667 mimd

Inertia [2) 'm mmrnd

Torsion Constant 1817708333.33333 rimd
Shear &rea [v) 'm mma
Shear &rea [z) 'm mma

Clear

Gross Area [x] |125000.0 mme Help
Example Figure 20.

Repeat the same process to add a 500x500 column section.

For compound section shapes not available in S-FRAME, you have a few options to define their

properties and perform an analysis:

1. Calculate the section properties (moment of inertia, torsion constant, shear area and gross
area) and add them manually by entering the values into the appropriate field

2. Use S-CALC™, a section property calculation tool, to calculate the section properties of
any shape, and import them into S-FRAME.

Proprietary Information of Altair Engineering

J\ ALTAIR


https://s-frame.com/index_files/SCALC.htm

Altair S-FRAME 2021.1
Quick Start Guide

p. 41

7. Inaddition to concrete sections, we will add a steel section next. Following the same process we add an |
shape (IPE 120) steel beam, for our roof beams from the European steel table as shown below:

a ErnH

L = 49.04 mm
T P30 5295 10°3mu3
6.300 Iy 0.2767 1
Sy 1358
v 447
4,400 Zy 86463

20

Py Steel Section Properties x
Toggle Urits SteslTable:  |European  ~| Ok
Section Mame:  [1PE 120 ~| Find Cancel
1PE 120 Dead | 1037, kg/m
Fron 1321 mm2
SA 04752 m2im
Ix 31775 1076 mmd Ment
- 60.73 10°3 mm3
Previcuis

hddta=

......... o, 16,90
Cw 0.8942
........ LN I
k 13.30
— Cost 1]
o=
64.00
List of sections to add to local database
IPE 120
Help
Example Figure 21.

To do this, right-click on the Section Properties Tool and this time select Steel to open the Steel Section
Properties Dialog. Select the European Steel Table and the IPE 120 section from the steel database. Click
“Add to => then Click OK to close the dialog.

8. The added sections should appear on the left-hand side in the Section Properties Tool dialog. Within this
dialog, you can change the display colour (select the section and select a colour), review the section
properties, and more. Once done, click Close to close the dialog.

[5 Section Properties Tool
File

Editlocal section datahase

Cloze

Section Name |Beam 260500

Current Section 1

Unifarm Solid Rectangle

[X Hide Section Mumbers

[ Exponential Format

LCancel

Update

PRl

Colamn BO0R500 Inettia fy) [2604166700.0 o
IPE 120 Inertia [z) [F51041660.0 o Delete
Tarsion Constant |1786593400.0 mmd
Steel...
Shear Area [v] |104166.66 mmz
Shear Area [z] |104166.66 e Concrete
Gross Area [x] [125000.0 e
Shapes...
Plastic section moduli Stress Paint (21] 0.0 mm
Ze{0o i Stress Point [y1) [0.0 i
=-[00 m3 Stress Point (z2] 0.0 mm
display color Stress Point (p2] 0.0 mm
2.22] CE 3 §9‘1 el Stress Point (23] 0.0 mm
Stress Point (p3] 0.0 mm
' ¥
Stress Point (z4] 0.0 mm
b3.23] lyd.24) Stress Paint [y4) |0.0 mm
Stress Phs
Product of Inertia lyz 0.0 i Help
Example Figure 22.

9. By default, S-FRAME assigns the first section to all of our members. We change the required elements’
section properties using the Select Special option.
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a. Unselect All
b. Go to Select 2 Special, and select Vertical elements only, then Click OK

While the Section Properties Tool is selected, click on the legend colour change the section (this can also
be done through the combo bar above).

d. Once the appropriate section is selected, create a fence to the entire model to assign the section to your
columns, as demonstrated below;

& e ot Men View Detoe [seiect [ settings Optons mun Window Hein :
DCEdHé 2 B XA+ H00 <« ¢-A-BAadidn v & +F 4 1, T@®0.
a - B e -8 -2 d T 3 Cien + I8 1 -SwUSEOAND = WerberTyes Bass
O G2 Uerbers -C - & &
Shortcuts X My Snchum o
[——
i-__ Y G Lowd Memders
L3 Lovel 1 B
W e e (]
- L0 Lewvel 3 Boawn: .
s | (me.
Die e - otmn
'; =L =§\ﬁ|;:
2 (<]
-
-
L4
1
b4 K
L] b
b3
m '3
E o
* "
L
2 | *
£ |
# . E a
i @
B af .
= & _}_
a
Loads. a,
Buaphical )
L3 | el
W | | — | — | — | .
CoaDetats| Mok Digaraom B I e
@on @on awon eon Son Mon Lom Lon @or fean xoam Son | Son ion [Fos | shes | flon gRon

Example Figure 23.

10. Following the same steps, assign the | shape beam to your roof beams (Diagonals), and render the model to
validate the assigned sections. Recall, the horizontal members were already assigned, by default, to the first
defined section.

Dedé 2 B2+ H08 v G- A-Hadhdh khh & +F 4 rEREM.
(-] = R3F i o - @ L -k T vem + BB TeelUS RO - memew Typws Oeam
Ok 4 Merzers 3 IPE 120 * e Secton Nurbers g Generste Foders G
Shotous ¥ My Strachus ® -
Goorreary | | e EPEIEPEIEY
 » 0 s L Mo

L1 Lvel 1 B

10 Lavel 2 R [ Gechonfropenes |

O Level 2 Deams

21 Lewel 1 Counns [ - Deam 2500500

L1 Lewel 2 Colamns. I : - Coumn S00x500

1 Peat [ BN

ANBEADF AT €T FlEHT % e R

Losds
Greghical

Sposerdsh . I n the ‘Render Model og ]
Humesical

Cad Disists A ' [ ﬂd
@or Mon agort eot Sor WMo Low Lot @ov dpon aAfen | Eoo (Bon | on [Fon |[Mon | Hor gRonr E3

Example Figure 24.
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11. The next step is to define Material Properties.
a. Select the Material Properties Tool
b. Select the Concrete C35 (BS8110) from the legend (clicking on its colour) or from the combo box

above

c. Create afence to include the entire structure

d. We have now assigned this material property to all members of our model. Open the previously created
Roof folder by clicking on it. Select the Steel EC3 material and create a fence which includes the entire
structure, to define the appropriate material to our roof beams.

B - AT 4 v

7 Covewes CHBER =

o B s ¥ T aen

i M et e Gy Fisas G

- !u 7 Corcrole LIRS = [Unmorr Troen Beam

7

Mor won oeon Son Won Low Lom @on deom xom

|
Son Mo iion | Fom | ¥on | Bon Gon

Example Figure 25.

12. Next, we define the support conditions of our structure.

a. Select the Supports Tool.

b.
C.
d

Note the constraints added in the Data bar above.
Switch to the left view, using the Aerial Window.

Create a fence which includes the joints of the basement of our structure.

< GaR 4 e = ¥

T A% AU Te Ll Ly A e o

& G o 0

sl T Bew 00

o Q1 el lSACAN) ¢ emtar Ty Ben
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o
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EEI=EI=

T

CadDoinhy | Model Digarces |

] 1
o

Eon
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Mor Lon Lon @on dpon xow |

[
S | on ison [ Fon | Wos | o gHom

Example Figure 26.
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e. Switch to an Isometric view and make sure that fully fixed supports have been defined for all basement

joints.

o < BB e - @
o0 2 e 0 [ o e e

cdok XV Beanhs0 o FR 1 SwdMSACANL - WemberTypes Boam

Er
& 2
>
L
a F 1 H
w i
-

su:::nll @ - If
Sprasdth_ _.:_ = J.__j
% Mol Dgariom. | laf [ MJ
Eon Mo akor oo Sor WMor low Lon Por don How o S Mon Sior [ Lo (Mo | Hor o =
Example Figure 27.
13. The last step of this example is defining a self-weight load case.
a. Switch to the Loads window
b. Clickthe New Load Case shortcut
c. Enter a Description for this load case, Self-Weight
d. Enter a Gravitational factor -1 about the Z axis
e. Click OKto complete the process
SRR 7 b | B o A =
oA gF Jow O [— Shels O Pangls 0 Daghiages 0 E_m.mﬁ"r&&]:&n}f/;mnes*w#
Shatouds 3 My Sinchurg ® :
: 3 e Load Membesy
1 Level 1 Beara
i [t T
+ 3 Level 1 Coherms .
i 3 Loz Cemrs o
¢ p i
; |
- [ e Fromses
I oo
E -“»::'.':jm
‘g e Loens
: 53 Hew Load Case x
= | Ding MewLasd Cass Name and Factors o]
E Luad Case Desespton: [e e ° Lancel
ﬁ Load CaseMumbes 1 °
Gramlabmnal Factors
o 18
£-Y
il @il Sede [T ComeniCame )
2 Q Lot Type:  Shae Lnad
o & m
a| | a
w L]
& &
=T [
|| ST = == Hele
Mumencal
BT | o | o
Sor Mon agen oot Sow Wow fow Lon o deon Afow fon frow [Fon | WMo Sion Lo (Mo | fHow Pow »

Example Figure 28.
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We can now run an analysis. Go to Run->Analysis, or click on the Run Analysis Shortcut.

= B V- Seeel 5 B CANY

Two Memeers §F Three seints 33" Ictuse sones o nven

w=@Ppeo.
[ Mermber Types Do

wection (%

& Fle Fdit Mesh View Define Select Settings Options | Run | Windew  Help
D& @ B+ X0 Analysis... fER KLY B +P| A
-] - B i E SVIEW t I
ik 4 Jonis 0 Uembers Shem 0 SFOUNDATION
S-STERL
Shorteues X iy Smuchan » S-CONCRETE ICD
m E S-LINE
_W_ [ Ares Losd Merrbers 5-PAD
el [T Lol 1 B SCALC
@ [0 Lewel 2 Deams
@ [ Lewel 3Brams Liniks > Y
- 1 Level 1 Colurrs /‘,./T .
Lewel 2 Cobumns -
. (] Vi .

Example Figure 29.

Select Linear Static in the Analysis Type dialog, and click OK — Save the file if prompted.

[ Analysis Type
Solve For Load
{" Cases

Analysis type options

1 P-Dela Static

) Nonlinear Static

) Unstressed Vibration

() P-Delts Stressed Vibration

() Nonlinear Stressed Vibration

) Unstressed Response Spectrum
) Linear Dynamic Time Histary

" Combinations {+ Both

) Nonlinear Dynamic: Time History

) P-Delta Buckling

() Monlinear Buckling

() Linear Static Maoving loads

) Nonlinear Static Maoving Loads

) P-Delta Stressed Response Spectrum
) Nonlinear Buasi-Static

Solution trail detail
Section Titles hd

LCancel

Defaults

Example Figure 30.

You may be asked first to save your model, click yes. Upon solving the model, S-FRAME opens a Solution
Summary window. Always examine the summary and check that there are no FYI's Warnings or Errors.

7| 5-Frame Solution Status

S5-FRAME FINITE ELEMENT AMALYSIS SOLVER (Ver 11.02.10)
COPYRIGHT (C) 1992-2016 S-FRBME SCOFTWARE INC.

2016-08-17,14:56:07.707
Phase 1: mMemory management ...

total number of FYI

total number of WARNINGS

total number of ERRORS
2016-08-17,14:56:07.975

Press any key to proceed to postprocessor

Phase 2: program initialization ...
Phase 3: mesh optimization ...
Phase 4: model definition ...
Phasze 5: element formulation ...
dynamic memory allocated: 78
Phase &: assenbly ...
Phase 7: golution and post-processing ...
linear static analysis
load case: 1
Phase 8: cleaning up .

[=[=] =
-~

Example Figure 31.
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JAN

If the solver encounters any issues, they are reported here. Each issue has an ID and we
refer to them as Solver Diagnostic Messages (SDM). All SDM are described greater detail
in the document found in the Online Resources.

Help—>Online Resources—>S-FRAME Analysis Documents

Hit the Enter key on your keyboard when you are ready to proceed. After the analysis phase, S-FRAME
launches the Graphical results window. In this window, you can view results of interest by selecting the
appropriate tool to click on the additional options in the data bar above.

First, you may want to set up the scale factors so that the results are easy to view. Select the Diagram scale
factors and styles shortcut to open the Diagrams dialog box shown below:

1. Select the Specify max projected length for Result diagram magnification option.
2. Setthe Max projected length to 10mm

3. Click OK to accept the changes

Note the additional options we have available for plotting results.
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Example Figure 32.
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Once the scale factors and styles have been set up, select a tool and the results associated with the tool are

displayed graphically.
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Example Figure 33.

For instance, to view the moment diagrams about the Y axis for the Self-Weight Load case and display the

minimum values;

on oo

Select the Load case of your interest

Select the Moment Diagram Tool

Select the moment diagram you want to plot
and the values you want to display
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Example Figure 34.
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Additionally, you can switch to the Numerical Results window, view results in a spreadsheet view and

generate reports as demonstrated in our Tutorial 09 - Numerical Results video.

p. 48

10.0 Validation and Sharing with S-VIEW

S-FRAME R 11.1 and later are compatible with our newer generation products (S-VIEW, S-CALC and S-

FOUNDATION).

&% File Edit View Search Format Settings Options Run Window Help -8
DEE&E ] & +P|4E~Q= 2 @00 -
=I8] [1- self weight ~l=eE
4l Load Cases |1 Stations | 5 ~|
X ViewGioups [All Sections  ~| Al Types | Paints Of Interest Only
Sherteuts X< My Structure x Row Member | LdCase | Station - Axial ¥ - Shear - Shear x-Torsn y - Moment z - Moment =
Geomety . No No No m kN KN KN KN-m kh-m kh-m
] Area Load Members 1 1 00000 17016 0.0003 7.3641 -0.0009 -5.7523 -0.0012
Lo [ Level 1 Beams 2 1 12500 17018 0.0003 38141 -0.0009 1.1090 -0.0008
Giraphical (7 Level 2 Beams 3 1 25000 17016 0.0003 -0.1359 -0.0009 3.2829 -0.0004
Spieadsh.. | | D Level 3 Beams 4 1 3.7500 17018 0.0003 -3.8859 -0.0009 0.7892 -0.0001 B
D Level 1 Columns 5 1 5.0000 17018 0.0003 -7.6359 -0.0008 -6.4320 0.0003
Mumerical.. (3 Level 2 Columns 6 2 1 0.0000 17016 -0.0003 7.6359 0.0008 -6.4320 0.0003
| — 3 Roof 7 1 12500 17016 -0.0002 38858 0.0003 07652 _0.0001
z 8 1 25000 17016 -0.0003 01359 0.0009 32829 -0.0004
9 1 37500 17016 -0.0003 36141 0.0009 11080 -0.0008
o 10 1 50000 17016 -0.0003 73641 0.0009 57523 -0.0012
pid " 3 1 0.0000 07111 -0.0002 7.3446 -0.0008 56702 0.0004
L 12 1 12500 07111 -0.0002 35046 -0.0008 11888 0.0002
ot 13 1 25000 07111 -0.0002 -0.1554 -0.0008 33184 -0.0001
e 14 1 37500 07111 -0.0002 -3.9054 -0.0008 07784 -0.0003
m 15 1 50000 07111 -0.0002 76554 -0.0008 £.4470 -0.0006
& 16 4 1 0.0000 07111 0.0002 7.6554 0.0008 -6.4470 -0.0006
;‘ 17 1 1.2500 07111 0.0002 3.9054 0.0008 07784 -0.0003
E: 18 1 25000 07111 0.0002 0.1554 0.0008 3.3164 -0.0001
i 19 1 37500 07111 0.0002 -3.5946 0.0008 11868 0.0002
2] 20 1 50000 07111 0.0002 7.3446 0.0008 56702 0.0004
=) 21 5 1 0.0000  0.7088 -0.0003 7.3458 -0.0004 56727 0.0008
3 2 1 12500 07098 -0.0003 35858 -0.0004 11859 0.0004
23 1 25000 07088 -0.0003 -0.1542 -0.0004 33169 0.0000
Example Figure 35.

S-VIEW is a free program that comes with S-FRAME. S-VIEW launches within S-FRAME by selecting from the
top menu bar Run->S-VIEW. This opens the S-VIEW window to allow users to view their model and analysis

results.
File Tools View Window Help
ISEtt'\ngs nx QUICK-START GUIDE S-FRAME AMALYSIS. TEL S-FRAME Software Inc.
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g | O] Display Object |~
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User Info Scroll mouse
Image Export
Visualization
fonck to animate the structure 1 ROTATION ABOUT ORIGIN;
Right-Click & Drag
Help| Camera Animftion | Groups [settings] - —
Animation 1 x .
| [ ] Screenshot
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Timeline a x
1 —
£ 0.8 — — T
E 06 T
o4 e
B02 . — —_—
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Example Figure 36.
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S-VIEW is very effective for investigating and validating your post analysis structure by rendering and
animating its behavior. It is also useful for sharing your models with colleagues - it is free to download and
runs independently of S-FRAME Analysis. Users without S-FRAME Analysis only need the native .sview file to
visually examine the model and results. Combined with S-FRAME design reports, S-VIEW presents a
complete picture of your model.

11.0 Additional Resources

So now that you have built, analyzed, and designed your first structure, where do you go from here?

To better understand S-FRAME Analysis’ capabilities and functionality, we recommend new users follow
through a series of video tutorials.

B3+ File Edit View Define Select Settings Options Run  Window Help

D=EH&E @ %Exznﬁ%x@ﬁ Contents...
B > % - i More - &y i Online Resources \ «I
Ok w Members 0 1 - Beam 250-500 ~ Hide Section Numbers ¢ Email Support...

About 5-FRAME...

Show Home Page...

Shortcuts 2 My Struchure X |

Additional Online Resources.

In Addition, you can find much more worked examples within the S-FRAME Help system and the
detailed manuals supplied in electronic (.PDF) format.

To help you progress from an S-FRAME “novice”to an S-FRAME “expert”, we also offer short
technical webinars on specific topics as well as in-depth online training classes. View the S-FRAME
Analysis Product Home Page to find scheduled training classes and webinars or visit our Support
page. Both webinar material and training classes qualify for Profession Development Hours (PDH).
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